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Introduction

Photonic crystal devices are periodic structures of alternating layers of materials with 
different refractive indices. This model demonstrates how to apply shape optimization to 
a photonic crystal. The objective function is to maximize the output power ratio between 
for two narrow frequency bands, while constraining the loss from below. This is achieved 
by letting GaAs pillars change position but not shape. The implementation makes use of 
the Free Shape Domain and Transformation features, so that gradient-based optimization can 
be applied.

Model Definition

The objective function, Φ is defined in terms of the average magnitude of the output 
powers for a given wavelength, λ:

The objective thus it to minimize the maximum of a list of objective functions. The MMA 
optimization solver is well suited to such problems. The constraint, ψ, is formulated as

The topology of the mesh is fixed to allow for gradient-based optimization. To simplify 
manufacturing, the shape of the cylinder is also fixed. Thus, the only thing that is allowed 
to change is the cylinder positions. If they are allowed to move far, they might collide and 
cause error messages about inverted elements or NaN/Inf values. To avoid this, the 
cylinders are constrained to move 50 nm in the x and y directions. 
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Results and Discussion

Figure 1 and Figure 2 show the z component of the electric field in the optimized 
geometry for the two of the wavelengths.

Figure 1: The z component of the electric field for the lower frequency band. The wave 
propagates to the lower output.
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Figure 2: The z component of the electric field for the higher frequency band. The wave 
propagates to the upper output. 

The optimization is able to achieve an output power ratio of less than 1 %. The constraints 
is not satisfied initially, so this takes priority in the beginning of the optimization. Figure 3 
shows that it is satisfied in the end (ψ = 0.25 nW/m). The line in the graph is based on an 
analysis, where the mesh has been regenerated in the deformed configuration. The 
purpose of this is to ensure that the optimization result does not rely on unphysical 
numerical effects.
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Figure 3: The two auxiliary objective functions are plotted as a function of the frequency. The 
points indicate the frequencies used to approximate the two frequency bands.
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1. J.D. Joannopoulus, R.D. Meade, and J.N. Winn, Photonic Crystals (Modeling the Flow 
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Application Library path: Wave_Optics_Module/Waveguides_and_Couplers/
photonic_crystal_demultiplexer_optimization

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Optics>Wave Optics>Electromagnetic Waves,

Frequency Domain (ewfd).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Wavelength Domain.

6 Click Done.

G E O M E T R Y  1

Create the geometry. To simplify this step, insert a prepared geometry sequence.

1 In the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
photonic_crystal_demultiplexer_optimization_geom_sequence.mph.

3 In the Geometry toolbar, click Build All.

4 Click the Zoom Extents button in the Graphics toolbar.

5 In the Model Builder window, collapse the Geometry 1 node.
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M A T E R I A L S

The refractive index of GaAs depends on the frequency. The material is added from the 
Optical Material Database.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Optical>Inorganic Materials>As - Arsenides>Experimental data>

GaAs (Gallium arsenide) (Skauli et al. 2003: n 0.97-17 um).

4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

GaAs (Gallium arsenide) (Skauli et al. 2003: n 0.97-17 um) (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Circle 1.

Air
1 In the Model Builder window, right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Air in the Label text field.

3 Select Domain 1 only.

4 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M A G N E T I C  W A V E S ,  F R E Q U E N C Y  D O M A I N  ( E W F D )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (ewfd).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Components section.

3 From the Electric field components solved for list, choose Out-of-plane vector.

Scattering Boundary Condition 1
1 In the Physics toolbar, click Boundaries and choose Scattering Boundary Condition.

Property Variable Value Unit Property group

Refractive index, real 
part

n_iso ; nii = n_iso, 
nij = 0

1 1 Refractive index
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2 In the Settings window for Scattering Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose All boundaries.

Scattering Boundary Condition 2
1 In the Physics toolbar, click Boundaries and choose Scattering Boundary Condition.

2 In the Settings window for Scattering Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Input Port.

4 Locate the Scattering Boundary Condition section. From the Incident field list, choose 
Wave given by E field.

5 From the Incident field list, choose Wave given by E field.

6 Specify the E0 vector as

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Build All.

D E F I N I T I O N S

Power port 1
1 In the Definitions toolbar, click Probes and choose Boundary Probe.

2 In the Settings window for Boundary Probe, type Power port 1 in the Label text field.

3 In the Variable name text field, type obj1.

4 Locate the Probe Type section. From the Type list, choose Integral.

5 Locate the Source Selection section. From the Selection list, choose Output Port 1.

6 Click Section toolbar in the upper-right corner of the Expression section. From the 
menu, choose Component 1 (comp1)>Electromagnetic Waves, Frequency Domain>

Energy and power>ewfd.nPoav - Power outflow, time average - W/m².

Power port 2
1 Right-click Power port 1 and choose Duplicate.

2 In the Settings window for Boundary Probe, type Power port 2 in the Label text field.

0 x

0 y

1 z
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3 In the Variable name text field, type obj2.

4 Locate the Source Selection section. From the Selection list, choose Output Port 2.

G L O B A L  D E F I N I T I O N S

Wave Parameter
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Wave Parameter in the Label text field.

Use three parameters to define two frequency bands.

3 Locate the Parameters section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Sequence Type section.

3 From the list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type meshsz.

4 In the Minimum element size text field, type meshsz/2.

5 In the Curvature factor text field, type Inf.

Size 1
1 In the Model Builder window, right-click Size 1 and choose Enable.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Selection list, choose Circle 1.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
meshsz/2.

Name Expression Value Description

lambda1 0.9[um] 9E-7 m First wavelength

lambda2 1[um] 1E-6 m Second wavelength

dWave 0.02[um] 2E-8 m Bandwidth

dWaveN 3 3 Frequencies per band

meshsz lambda2/12 8.3333E-8 m Mesh size
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5 In the Minimum element size text field, type meshsz/4.

6 Clear the Maximum element growth rate check box.

7 Clear the Curvature factor check box.

8 Clear the Resolution of narrow regions check box.

9 Click Build All.

S T U D Y  1

Step 1: Wavelength Domain
1 In the Model Builder window, under Study 1 click Step 1: Wavelength Domain.

2 In the Settings window for Wavelength Domain, locate the Study Settings section.

3 From the Wavelength unit list, choose m.

4 In the Wavelengths text field, type range(lambda1-50[nm],5[nm],lambda2+
50[nm]).

5 Click to expand the Results While Solving section. From the Probes list, choose None.

6 In the Model Builder window, click Study 1.

7 In the Settings window for Study, type Initial Design in the Label text field.

8 In the Home toolbar, click Compute.

D E F I N I T I O N S

In the Definitions toolbar, click Optimization and choose Shape Optimization>

Free Shape Domain.

S H A P E  O P T I M I Z A T I O N

Free Shape Domain 1
1 In the Settings window for Free Shape Domain, locate the Domain Selection section.

2 From the Selection list, choose All domains.

Transformation 1
1 In the Definitions toolbar, click Optimization and choose Shape Optimization>

Transformation.

2 In the Settings window for Transformation, locate the Geometric Entity Selection section.

3 From the Selection list, choose Circle 1.
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4 Locate the Translation section. In the table, enter the following settings:

5 Locate the Scaling section. From the Scaling type list, choose No scaling.

D E F I N I T I O N S

Objective Function
1 In the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, type Objective Function in the Label 
text field.

3 In the Variable name text field, type obj.

4 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1 (comp1)>Electromagnetic Waves, Frequency Domain>

ewfd.lambda0 - Wavelength in free space - m.

5 Locate the Expression section. In the Expression text field, type 
if(ewfd.lambda0<(lambda1+lambda2)/2,obj1/obj2,obj2/obj1).

The if statement causes the ratio to be inverted for one frequency band relative to the 
other.

Constraint
1 In the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, type Constraint in the Label text field.

3 In the Variable name text field, type constr.

4 Locate the Expression section. In the Expression text field, type (obj1+obj2)/0.25[nW/
m].

2.5e-10 provides a good compromise between demultiplexing and overall 
transmission.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces>Wavelength Domain.

 Lock Lower bound (m) Upper bound (m)

X -5E-8 5E-8

Y -5E-8 5E-8
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4 Click Add Study in the window toolbar.

5 In the Select Study tree, select Empty Study.

6 Click Add Study in the window toolbar.

7 In the Home toolbar, click Add Study to close the Add Study window.

Disable the shape optimization for the first study.

I N I T I A L  D E S I G N

Step 1: Wavelength Domain
1 In the Model Builder window, under Initial Design click Step 1: Wavelength Domain.

2 In the Settings window for Wavelength Domain, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for Deformed geometry (Component 1).

S T U D Y  2

Step 1: Wavelength Domain
Approximate each frequency band by three frequencies.

1 In the Model Builder window, under Study 2 click Step 1: Wavelength Domain.

2 In the Settings window for Wavelength Domain, locate the Study Settings section.

3 In the Wavelengths text field, type range(lambda1-dWave/2,dWave/(dWaveN-1),
lambda1+dWave/2) range(lambda2-dWave/2,dWave/(dWaveN-1),lambda2+

dWave/2).

4 Locate the Results While Solving section. From the Probes list, choose None.

Shape Optimization
1 In the Study toolbar, click Optimization and choose Shape Optimization.

2 In the Settings window for Shape Optimization, locate the Optimization Solver section.

3 In the Maximum number of iterations text field, type 50.

4 Clear the Move limits check box.

5 Click Add Expression in the upper-right corner of the Objective Function section. From 
the menu, choose Component 1 (comp1)>Definitions>comp1.obj - Objective Function.
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6 Locate the Objective Function section. From the Solution list, choose 
Maximum of objectives.

This causes the solver to identify the frequency associated with the maximum objective 
function and prioritize this over the other frequencies (while still taking all frequencies 
into account).

7 Click Add Expression in the upper-right corner of the Constraints section. From the 
menu, choose Component 1 (comp1)>Definitions>comp1.constr - Constraint.

8 Locate the Constraints section. In the table, enter the following settings:

This prevents the optimization solver from generating a design with poor transmission 
to the output ports.

9 Locate the Output While Solving section. From the Probes list, choose None.

10 In the Model Builder window, click Study 2.

11 In the Settings window for Study, type Shape Optimization in the Label text field.

12 In the Study toolbar, click Get Initial Value.

13 In the Model Builder window, click Shape Optimization.

14 In the Settings window for Shape Optimization, locate the Output While Solving section.

15 Select the Plot check box.

16 From the Plot group list, choose Shape Optimization.

Solution 2 (sol2)
1 In the Model Builder window, expand the Shape Optimization>Solver Configurations node.

2 In the Model Builder window, expand the Solution 2 (sol2) node.

3 In the Model Builder window, expand the Shape Optimization>Solver Configurations>

Solution 2 (sol2)>Optimization Solver 1>Stationary 1 node.

4 Right-click Stationary 1 and choose Segregated.

5 In the Settings window for Segregated, locate the General section.

6 From the Termination technique list, choose Iterationsto reduce the computational time.

7 Right-click Segregated 1 and choose Segregated Step.

8 In the Settings window for Segregated Step, locate the General section.

9 In the Variables list, select Electric field (spatial and material frames) (comp1.E).

10 Under Variables, click Delete.

Expression Lower bound Upper bound

comp1.constr 1
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11 In the Model Builder window, click Segregated Step 1.

12 In the Settings window for Segregated Step, locate the General section.

13 Under Variables, click Add.

14 In the Add dialog box, in the Variables list, choose 
Electric field (spatial and material frames) (comp1.E) and 
Translation (geometry frame) (comp1.tsf1.move).

15 Click OK.

16 In the Settings window for Segregated Step, click Compute.

R E S U L T S

Shape Optimization/Solution 2 (sol2)
1 In the Model Builder window, expand the Results>Datasets node.

2 Right-click Results>Datasets>Shape Optimization/Solution 2 (sol2) and choose 
Remesh Deformed Configuration.

I N I T I A L  D E S I G N

Step 1: Wavelength Domain
In the Model Builder window, under Initial Design right-click Step 1: Wavelength Domain and 
choose Copy.

S T U D Y  3

In the Model Builder window, right-click Study 3 and choose Paste Wavelength Domain.

Step 1: Wavelength Domain
1 In the Settings window for Wavelength Domain, locate the Physics and Variables Selection 

section.

2 In the table, clear the Solve for check box for Deformed geometry (Component 1).

3 Click to expand the Values of Dependent Variables section. Find the 
Values of variables not solved for subsection. From the Settings list, choose 
User controlled.

4 From the Method list, choose Solution.

5 From the Study list, choose Shape Optimization, Wavelength Domain.

6 Find the Store fields in output subsection. From the Settings list, choose For selections.

7 Under Selections, click Add.

8 In the Add dialog box, in the Selections list, choose Output Port 1 and Output Port 2.
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9 Click OK.

10 In the Settings window for Wavelength Domain, click to expand the Mesh Selection 
section.

11 In the table, enter the following settings:

12 In the Model Builder window, click Study 3.

13 In the Settings window for Study, type Verification in the Label text field.

14 Locate the Study Settings section. Clear the Generate default plots check box.

15 In the Home toolbar, click Compute.

R E S U L T S

Electric Field (initial)
1 In the Model Builder window, under Results click Electric Field (ewfd).

2 In the Settings window for 2D Plot Group, type Electric Field (initial) in the 
Label text field.

Surface 1
1 In the Model Builder window, expand the Electric Field (initial) node, then click Surface 1.

2 In the Settings window for Surface, click Section toolbar in the upper-right corner of the 
Expression section. From the menu, choose Component 1 (comp1)>

Electromagnetic Waves, Frequency Domain>Electric>Electric field - V/m>ewfd.Ez -

Electric field, z component.

3 Locate the Coloring and Style section. From the Color table list, choose WaveLight.

Streamline 1
1 In the Model Builder window, right-click Electric Field (ewfd) 1 and choose Streamline.

2 In the Settings window for Streamline, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1 (comp1)>

Electromagnetic Waves, Frequency Domain>Energy and power>ewfd.Poavx,ewfd.Poavy -

Power flow, time average (spatial and material frames).

3 Locate the Selection section. From the Selection list, choose Input Port.

4 Locate the Coloring and Style section. Find the Line style subsection. From the Type list, 
choose Tube.

5 Select the Radius scale factor check box.

Component Mesh

Component 1 Mesh 2
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6 In the Tube radius expression text field, type 3e-9.

7 Find the Point style subsection. From the Color list, choose Black.

Surface 1
1 In the Model Builder window, click Surface 1.

2 In the Settings window for Surface, click Section toolbar in the upper-right corner of the 
Expression section. From the menu, choose Component 1 (comp1)>

Electromagnetic Waves, Frequency Domain>Electric>

Electric field (spatial and material frames) - V/m>ewfd.Ez - Electric field, z component.

3 Locate the Coloring and Style section. From the Color table list, choose WaveLight.

4 From the Scale list, choose Linear symmetric.

Electric Field (optimized)
1 In the Model Builder window, under Results click Electric Field (ewfd) 1.

2 In the Settings window for 2D Plot Group, type Electric Field (optimized) in the 
Label text field.

3 Click Plot Previous.

4 In the Electric Field (optimized) toolbar, click Plot.

5 Click the Zoom Extents button in the Graphics toolbar.
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6 Click Plot Previous three times.

7 In the Electric Field (optimized) toolbar, click Plot.

Create a new plot 1D Plot Group for the spectrum.

Spectrum
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Spectrum in the Label text field.

3 Locate the Data section. From the Dataset list, choose Verification/Solution 3 (sol3).

4 Click to expand the Title section. From the Title type list, choose None.

5 Locate the Plot Settings section. Select the y-axis label check box.

6 In the associated text field, type P (nW/m).

7 Locate the Legend section. From the Position list, choose Middle right.

Global 1
1 Right-click Spectrum and choose Global.

2 In the Settings window for Global, click Add Expression in the upper-right corner of the 
y-Axis Data section. From the menu, choose Component 1 (comp1)>Definitions>obj1 -

Power port 1 - W/m.
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3 Click Add Expression in the upper-right corner of the y-Axis Data section. From the 
menu, choose Component 1 (comp1)>Definitions>obj2 - Power port 2 - W/m.

4 Locate the y-Axis Data section. In the table, enter the following settings:

5 Locate the x-Axis Data section. From the Unit list, choose µm.

6 Click to expand the Coloring and Style section. In the Width text field, type 2.

Global 2
1 Right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Dataset list, choose Shape Optimization/Solution 2 (sol2).

4 Locate the Coloring and Style section. Find the Line style subsection. From the Line list, 
choose None.

5 Find the Line markers subsection. From the Marker list, choose Square.

6 From the Positioning list, choose In data points.

7 From the Color list, choose Cycle (reset).

8 Locate the y-Axis Data section. In the table, enter the following settings:

9 In the Spectrum toolbar, click Plot.

Expression Unit Description

obj1 nW/m Power port 1 (mesh2)

obj2 nW/m Power port 2 (mesh2)

Expression Unit Description

obj1 nW/m Power port 1

obj2 nW/m Power port 2
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10 Click the Zoom Extents button in the Graphics toolbar.

Shape Optimization
Finally, create a new 2D Plot Group for the thumbnail.

Thumbnail
1 In the Model Builder window, right-click Shape Optimization and choose Duplicate.

2 In the Model Builder window, click Shape Optimization 1.

3 In the Settings window for 2D Plot Group, type Thumbnail in the Label text field.

4 Locate the Plot Settings section. Clear the Plot dataset edges check box.

Line 1
1 In the Model Builder window, expand the Results>Thumbnail>

Translation (Transformation 1) node, then click Results>Thumbnail>Line 1.

2 In the Settings window for Line, locate the Coloring and Style section.

3 From the Line type list, choose Tube.

4 Select the Radius scale factor check box.

5 In the Tube radius expression text field, type 5e-9.

Line 2
1 In the Model Builder window, right-click Line 1 and choose Duplicate.
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2 In the Settings window for Line, locate the Coloring and Style section.

3 From the Color list, choose Gray.

Deformation 1
1 Right-click Line 2 and choose Deformation.

2 In the Settings window for Deformation, click Section toolbar in the upper-right corner 
of the Expression section. From the menu, choose Component 1 (comp1)>Definitions>

Transformation 1>tsf1.dXg,tsf1.dYg - Boundary displacement (geometry frame).

3 Locate the Expression section. In the X component text field, type -tsf1.dXg.

4 In the Y component text field, type -tsf1.dYg.

5 Locate the Scale section. Select the Scale factor check box.

6 In the associated text field, type 1.

Color Expression 1
1 In the Model Builder window, under Results>Thumbnail>Translation (Transformation 1) 

click Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type sqrt(material.dX^2+material.dY^2).

4 Click to expand the Range section. Clear the Manual color range check box.

Filter 1
1 In the Model Builder window, right-click Line 1 and choose Filter.

2 In the Settings window for Filter, locate the Element Selection section.

3 In the Logical expression for inclusion text field, type (abs(X-xCenter)<1e-6)*
(abs(Y)<1e-6).

4 Right-click Filter 1 and choose Copy.

Filter 1
In the Model Builder window, right-click Translation (Transformation 1) and choose 
Paste Filter.

Filter 1
1 In the Model Builder window, right-click Line 2 and choose Paste Filter.

2 In the Thumbnail toolbar, click Plot.
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3 Click the Zoom Extents button in the Graphics toolbar.

Geometry Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Blank Model.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

W 3.375[um] 3.375E-6 m Design Domain Width

H W 3.375E-6 m Design Domain Height

rHole 0.07[um] 7E-8 m Hole Radius
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A D D  C O M P O N E N T

In the Home toolbar, click Add Component and choose 2D.

G E O M E T R Y  1

Rectangle 1 (r1)
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type W.

4 In the Height text field, type H.

5 Locate the Position section. In the y text field, type -H/2.

Circle 1 (c1)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type rHole.

4 Locate the Position section. In the y text field, type -2*dPeriod*sin(pi/3)*round(H/
dPeriod/sin(pi/3)/3).

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
check box.

Move 1 (mov1)
1 In the Geometry toolbar, click Transforms and choose Move.

2 In the Settings window for Move, locate the Input section.

3 From the Input objects list, choose Circle 1.

4 Select the Keep input objects check box.

5 Locate the Displacement section. In the y text field, type sin(pi/3)*dPeriod.

6 In the x text field, type cos(pi/3)*dPeriod.

Array 1 (arr1)
1 In the Geometry toolbar, click Transforms and choose Array.

2 In the Settings window for Array, locate the Input section.

3 From the Input objects list, choose Circle 1.

dPeriod 5*rHole 3.5E-7 m Periodicity

xCenter 5*dPeriod 1.75E-6 m Center Hole

Name Expression Value Description
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4 Locate the Size section. In the x size text field, type round(W/dPeriod)+1.

5 In the y size text field, type round(H/dPeriod).

6 Locate the Displacement section. In the x text field, type dPeriod.

7 In the y text field, type 2*sin(pi/3)*dPeriod.

Circles to Keep
1 In the Geometry toolbar, click Selections and choose Box Selection.

2 In the Settings window for Box Selection, type Circles to Keep in the Label text field.

3 Locate the Box Limits section. In the x minimum text field, type 0.

4 In the x maximum text field, type W.

5 In the y minimum text field, type -H/2.

6 In the y maximum text field, type H/2.

7 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

8 Locate the Input Entities section. From the Entities list, choose From selections.

9 Click Add.

10 In the Add dialog box, select Circle 1 in the Selections list.

11 Click OK.

Circles to Delete
1 In the Geometry toolbar, click Selections and choose Difference Selection.

2 In the Settings window for Difference Selection, type Circles to Delete in the Label 
text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog box, select Circle 1 in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference Selection, locate the Input Entities section.

7 Click Add.

8 In the Add dialog box, select Circles to Keep in the Selections to subtract list.

9 Click OK.

Input Port
1 In the Geometry toolbar, click More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, type Input Port in the Label text field.
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3 Locate the Starting Point section. From the Specify list, choose Coordinates.

4 In the y text field, type -dPeriod/2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the y text field, type dPeriod/2.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
check box.

Output Port 1
1 Right-click Input Port and choose Duplicate.

2 In the Settings window for Line Segment, type Output Port 1 in the Label text field.

3 Locate the Starting Point section. In the x text field, type xCenter+H/sqrt(3)/2-
dPeriod/sqrt(3).

4 In the y text field, type H/2.

5 Locate the Endpoint section. In the x text field, type xCenter+H/sqrt(3)/2+dPeriod/
sqrt(3).

6 In the y text field, type H/2.

Output Port 2
1 Right-click Output Port 1 and choose Duplicate.

2 In the Settings window for Line Segment, type Output Port 2 in the Label text field.

3 Locate the Starting Point section. In the y text field, type -H/2.

4 Locate the Endpoint section. In the y text field, type -H/2.

Circles to Delete, row1
1 In the Geometry toolbar, click Selections and choose Box Selection.

2 In the Settings window for Box Selection, type Circles to Delete, row1 in the Label 
text field.

3 Locate the Box Limits section. In the x maximum text field, type xCenter+2*rHole.

4 In the y minimum text field, type -rHole.

5 In the y maximum text field, type rHole.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Rotate 1 (rot1)
1 In the Geometry toolbar, click Transforms and choose Rotate.

2 In the Settings window for Rotate, locate the Input section.
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3 From the Input objects list, choose Circle 1.

4 Locate the Rotation section. In the Angle text field, type 120.

5 Locate the Center of Rotation section. In the x text field, type xCenter.

Circles to Delete, row2
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Circles to Delete, row1 (boxsel2) and choose Duplicate.

2 In the Settings window for Box Selection, type Circles to Delete, row2 in the Label 
text field.

Rotate 2 (rot2)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 
Rotate 1 (rot1) and choose Duplicate.

Circles to Delete, row3
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Circles to Delete, row2 (boxsel3) and choose Duplicate.

2 In the Settings window for Box Selection, type Circles to Delete, row3 in the Label 
text field.

Rotate 3 (rot3)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 
Rotate 2 (rot2) and choose Duplicate.

Circles to Delete, rows
1 In the Geometry toolbar, click Selections and choose Union Selection.

2 In the Settings window for Union Selection, type Circles to Delete, rows in the Label 
text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog box, in the Selections to add list, choose Circles to Delete, 
Circles to Delete, row1, Circles to Delete, row2, and Circles to Delete, row3.

5 Click OK.

Delete Entities 1 (del1)
1 In the Model Builder window, right-click Geometry 1 and choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Circles to Delete, rows.
25 |  O P T I M I Z A T I O N  O F  A  P H O T O N I C  C R Y S T A L  F O R  D E M U L T I P L E X I N G



photonic_crystal_demultiplexer_optimization.fm  Page 26  Monday, November 1, 2021  2:37 PM
Circle Boundaries
1 In the Geometry toolbar, click Selections and choose Adjacent Selection.

2 In the Settings window for Adjacent Selection, type Circle Boundaries in the Label text 
field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog box, select Circle 1 in the Input selections list.

5 Click OK.

Form Union (fin)
1 In the Model Builder window, click Form Union (fin).

2 In the Settings window for Form Union/Assembly, click Build Selected.

3 Click the Zoom Extents button in the Graphics toolbar.

The model geometry is now complete.
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